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PRAKATA 
 

 

 

Puji syukur kepada Allah Swt. karena atas rahmat dan hidayah-Nya sehingga buku 

ini dapat diselesaikan. Selawat dan salam senantiasa tercurah kepada Rasulullah 

Muhammad shallallahu alaihi wasallam, segenap keluarga, sahabat, dan para 

pengikutnya. 

 

Dalam buku ini, penulis memaparkan uraian singkat penerapan Metode Elemen 

Hingga untuk menganalisis pelat berpenegar. Analisis kekuatan pelat berpenegar 

dengan Metode Elemen Hingga memberi kontribusi yang sangat besar di bidang 

struktur karena dapat memberi informasi bagaimana perilaku struktur sebelum 

dan setelah memperoleh pembebanan. Pelat berpenegar yang dijadikan contoh 

dalam buku ini adalah Angle-bar, Flat-bar, dan Tee-bar. Ketiga jenis pelat 

berpenegar tersebut dianalisis dengan menggunakan software ANSYS. Tahapan 

analisis diawali dengan pemodelan, kemudian proses analisis, dan terakhir adalah 

luaran dari hasil analisis.  

 

Pada tahapan pemodelan meliputi input data dimensi berupa panjang, lebar, dan 

tebal dari penampang pelat berpenegar. Kemudian pembentukan meshing 

(jaring), input beban, dan kondisi batas. Tahapan proses dilakukan dengan me-

running dari model dan input yang telah dimasukkan. Tahapan luaran atau output 

adalah berupa teks dan gambar. Adapun luaran yang berupa teks misalnya jumlah 

elemen, jumlah titik, inersia penampang. Sedangkan luaran yang tidak hanya 

menghasilkan teks namun juga menghasilkan gambar di antaranya adalah 

tegangan, momen, dan deformasi.  

 

Penyusunan buku ini masih jauh dari kata sempurna. Untuk itu, penulis memohon 

maaf apabila terdapat kesalahan dalam buku ini. Penulis berharap pembaca buku 

ini memberikan saran atau masukan untuk pengembangan selanjutnya. 

Akhir kata, penulis mengucapkan terima kasih kepada semua pihak atas 

bantuannya dalam penyusunan buku ini. Semoga buku ini bernilai ibadah bagi 

penulis dan bermanfaat bagi para pembaca. 

 

Makassar, April 2022 

 

 

Penulis 
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GLOSARIUM 
 

 

 

ANSYS : Software yang digunakan untuk menganalisis struktur 

 

FEM : Metode Elemen Hingga untuk menganalisis struktur yang 

berbasis numerik 

 

Deformasi : Perubahan bentuk pada struktur yang disebabkan oleh 

pembebanan yang bekerja pada struktur 

 

Mesh : Membagi struktur menjadi elemen-elemen yang lebih 

sederhana 

 

Modulus Elastisitas : Angka yang digunakan untuk mengukur objek atas 

ketahanan bahan yang mengalami deformasi elastis ketika 

gaya diterapkan pada benda itu 

 

Modulus Geser : Kecenderungan sebuah objek untuk bergeser (deformasi 

bentuk pada volume konstan) ketika diberikan kekuatan 

yang berlawanan 

 

Rasio Poison : Konstanta elastisitas yang dimiliki oleh setiap material 

 

Tensile Strength : Tegangan maksimum yang bisa ditahan oleh sebuah 

bahan ketika ditarik sebelum bahan tersebut putus 

 

Ultimate Strength :  Kekuatan batas 
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PENDAHULUAN 

BAB 1  PENDAHULUAN 

 

 

 

 

1.1. Umum 

 

Panel kaku adalah bagian yang sangat umum untuk kapal dan struktur lepas 

pantai. Oleh karena itu, daya dukung beban panel yang dikakukan adalah faktor 

penting bagi keselamatan kapal. Selama kapal berlayar, kecelakaan mungkin 

terjadi seperti kebakaran, yang dapat menyebabkan perubahan mekanik dan sifat 

termo-fisik baja karbon dan menghasilkan tegangan termal. Hal ini dapat 

menyebabkan kerusakan pada panel lokal dan kemudian mempengaruhi daya 

dukung beban dari hull girder. Respons mekanis kapal dan struktur lepas pantai di 

bawah beban termal dilakukan secara bertahap dan diperhatikan lebih saat ini 

untuk keamanan struktur selama desain (Ming Cai Xu et al., 2021). 

 

Elemen pelat dan pelat yang kaku berfungsi sebagai unit dasar lambung struktur. 

Struktur pelat lokal pertama-tama mengalami kegagalan tekuk lokal yang dibebani 

beban eksternal saat lambung kapal mengalami collapse. Ketika lambung kapal 

mengalami momen lentur vertikal, struktur dek dan pelat bawah mengalami beban 

tarik dan tekan. Struktur dek atau pelat bawah terutama menunjukkan tekuk atau 

menghasilkan perilaku. Dengan demikian, sangat penting untuk menganalisis daya 

dukung batas dari struktur pelat yang terkena beban tekan untuk desain struktur 

kapal yang aman (Leo Ao et al., 2020). 

 

Analisis kekuatan pelat sudah banyak dilakukan oleh peneliti sebelumnya. Estimasi 

kekuatan batas dari stiffener cangkang silinder dalam pengaruh beban tekan 

eksternal dengan tekuk cangkang lokal atau tekuk puntir dari stiffener dilakukan 

oleh Daisuke Shiomitsu dan Daisuke Yanagihara (2021). Kekuatan batas panel 

kaku yang diberi beban dorong tidak seragam dianalisis oleh Konstantinos N. 

Anyfantis (2020). Sebuah studi parametrik tentang efek korosi pitting pada 

kekuatan batas panel yang juga sudah dikakukan oleh Liang Feng et al. (2020).  
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Evaluasi kekuatan batas sisa pelat yang dikakukan dengan lekukan pusat yang 

diberi gaya dorong membujur dianalisis oleh Lei Ao et al. (2020). Investigasi 

eksperimental dan numerik yang dilakukan oleh Jinju Cui dan Deyu Wang (2020) 

pada kekuatan batas pelat kaku dengan korosi bukaan dan perforasi. Formulasi 

kekuatan batas sisa dari silinder kaku baja yang rusak secara lokal di bawah 

beban gabungan yang dianalisis Quang Thang Do et al. (2021). 

 

Investigasi eksperimental dan numerik oleh Zhenfei Guo et al. (2021) pada 

kekuatan batas pelat kaku yang dilas laser dengan mempertimbangkan deformasi 

pengelasan dan tegangan sisa. Sebuah studi tentang kekuatan batas residual dari 

panel yang dikakukan terus-menerus dengan retakan di bawah kombinasi tekanan 

lateral dan kompresi dalam panel dianalisis oleh Poknam Han et al. (2021). 

 

Wentao He et al. (2020) melakukan penilaian kekuatan batas sisa probabilistik dari 

pelat tanpa penumpu dan pelat yang retak di bawah kompresi uniaksial. Pengaruh 

tegangan sisa pada kekuatan batas stiffener kaku yang dikompresi secara 

longitudinal oleh Shen Li (2021). Desain konstruksi untuk peningkatan tegangan 

tekuk batas pelat yang dikakukan ke beban tekan uniaksial dianalisis oleh João 

Paulo Silva Lima et al. (2020). 

 

Analisis eksperimental dan numerik kekuatan tekan panel yang dikakukan dengan 

bukaan oleh Bin Liu et al. (2020). Hongyang Ma et al. (2021) melakukan studi 

eksperimental dan numerik tentang kekuatan batas pelat yang dikakukan yang 

dikenai kombinasi kompresi biaksial dan beban lateral. Studi eksperimental dan 

numerik tentang kekuatan batas dari pengaku kolom di bawah kompresi aksial 

oleh Hongyuan Mei et al. (2020). Ketahanan pemungkas pelat melengkung yang 

dikakukan secara longitudinal yang mengalami kompresi murni dianalisis oleh Sara 

Piculin et al. (2021). Analisis eksperimental dan numerik kekuatan tekan 

pemungkas panel kaku bentang panjang oleh Bin Liu et al. (2021). 

 

Penilaian numerik percobaan pada kekuatan batas sisa pelat yang dikakukan 

dengan retakan oleh Xing Hua Shi et al. (2019). Studi numerik dan eksperimental 

tentang pengaruh kondisi batas selama pengujian pelat yang dikenai beban tekan 

dianalisis oleh Krzysztof Woloszyk et al. (2021). Evaluasi eksperimental kekuatan 

batas panel yang dikakukan di bawah kompresi longitudinal oleh Ming Cai Xu et al. 

(2021). Kekuatan batas dinamis pelat pengaku bagian bawah luar di bawah 

kompresi dalam bidang dan tekanan lateral oleh Bin Yang et al. (2018). Studi 

eksperimental dan numerik tentang respons dinamis pelat yang dikakukan di 

bawah beban ledakan terbatas oleh Nan Zhao et al. (2020). 
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1.2. Inti Permasalahan 

 

Untuk menganalisis kekuatan pelat dengan presisi dibutuhkan perhitungan yang 

lebih akurat. Namun, saat ini masih kurangnya referensi menganalisis kekuatan 

pelat yang berbasis numerik. Oleh karena itu, dengan menggunakan Metode 

Elemen Hingga ini, maka permasalahan analisis kekuatan pelat bisa diselesaikan 

dan memperoleh hasil yang lebih presisi. Keuntungan lain dengan menggunakan 

metode ini adalah perilaku struktur seperti tegangan dan deformasi dapat 

ditampilkan secara grafik detail elemen yang mengalami perubahan bentuk akibat 

beban yang bekerja. 

 

Analisis kekuatan pelat dapat dilakukan dengan menggunakan beberapa metode 

dan salah satu metode sudah disinggung pada paragraf sebelumnya di antaranya 

adalah: 

1. Pendekatan persamaan dengan asumsi distribusi tegangan 

2. Pendekatan modulus penampang 

3. Metode Elemen Hingga (FEM) 

 

Metode yang pertama sangat sederhana tetapi keakuratannya tergantung pada 

asumsi distribusi tegangan. Progressive collapse behavior yang diikuti oleh post-

ultimate capacity dari elemen yang tertekuk tidak dapat direfleksikan dengan 

benar dalam estimasi. Metode kedua telah diterapkan dalam aturan klasifikasi 

yang ditemukan dalam single step ultimate capacity method dalam IACS/CSR-OT. 

 

Metode ketiga adalah Metode Elemen Hingga (FEM), merupakan salah satu yang 

paling berguna untuk mengetahui nonlinear collapse behavior dari struktur. 

Karena perkembangan kemampuan komputasi, banyak peneliti menggunakan 

Nonlinear Finite Element Analysis untuk mengestimasi kekuatan struktur, 

kemudian dibandingkan dengan solusi analitis. 
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KONSEP DASAR ELEMEN HINGGA 

BAB 2 KONSEP DASAR ELEMEN HINGGA 

 

 

 

 

2.1. Pengertian 

 

Konsep dasar yang melandasi Metode Elemen Hingga adalah prinsip diskretisasi, 

yaitu membagi suatu benda menjadi elemen-elemen yang berukuran lebih kecil 

supaya lebih mudah pengelolaannya. Misalnya suatu bidang yang tidak beraturan 

(kontinum) didiskretisasi menjadi elemen-elemen yang lebih kecil (Elemen Hingga) 

yang bentuknya lebih teratur dari bentuk semula. Persamaan Metode Elemen 

Hingga pada suatu masalah tertentu menghasilkan suatu sistem persamaan 

aljabar serentak dalam penyelesaiannya. Pendekatan nilai hasil metode ini ialah 

terletak pada sejumlah daerah terbagi (diskret) pada titik-titik dalam suatu 

rangkaian kesatuan. Oleh karena itu, pada penyelesaian metode ini benda 

diasumsikan dibagi-bagi dalam suatu sistem ekuivalen pada unit-unit kecil 

berhingga (Elemen-elemen Hingga) yang saling berhubungan pada titik-titik 

hubung pada dua atau lebih elemen yang dikenal dengan istilah titik nodal atau 

nodes. Daerah permukaan yang dibatasi oleh garis-garis batas permukaan disebut 

dengan istilah diskretisasi (William Weaver, Jr. dan Paul R. Johnston, 1989). 

 

Metode Elemen Hingga (Finite Element Method) merupakan suatu metode 

numerik yang digunakan untuk menghitung gaya dalam pada suatu struktur. 

Finite Element Method (FEM) juga dapat dipakai untuk perhitungan nonstruktur, 

seperti fluida, perpindahan panas, mekanika nuklir, transportasi massa, dan lain-

lain. Keuntungan dari Metode Elemen Hingga adalah bahwa apa yang tidak dapat 

diselesaikan dengan penyelesaian analitis dapat dipecahkan dengan metode ini, 

sebagai contoh konstruksi yang mempunyai geometris yang kompleks dan beban 

yang kompleks (Leo Ao et al., 2020). 

 

Metode Nonlinear Finite Element Analysis (NLFEA) adalah Metode Elemen Hingga 

yang digunakan dan direkomendasikan oleh badan klasifikasi dan rekomendasi 

tersebut tidak hanya nasional tetapi juga internasional untuk menghitung struktur, 

di samping metode lainnya seperti teori balok, metode presumed stress 

BAB 
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distribution, ISUM, dan ISFEM. Pembentukan Model Elemen Hingga (FEM) presisi 

tinggi dapat memperoleh tegangan struktural dan perhitungan deformasi yang 

lebih komprehensif untuk mengeksplorasi mekanisme deformasi secara 

mendalam, menganalisis secara efektif faktor-faktor pengaruh kegagalan 

struktural, dan memandu desain struktur dan optimalisasi proses pengelasan. 

Dalam studi numerik, deformasi pengelasan dan tegangan sisa pelat yang 

dikakukan yang disebabkan oleh pengelasan sinar laser dua sisi disimulasikan 

dengan analisis termal-mekanik yang digabungkan secara berurutan (Zhenfei Guo 

et al., 2021). 

 

2.2. Rumus Dasar 

 

Metode Elemen Hingga merupakan metode numerik yang digunakan untuk 

menyelesaikan permasalahan dalam bidang rekayasa seperti geometri, 

pembebanan, dan sifat-sifat dari material yang sangat rumit. Selain itu, metode ini 

juga dapat digunakan untuk menyelesaikan masalah struktural, termal, dan 

elektromagnetik. Dalam metode ini, seluruh masalah yang kompleks seperti variasi 

bentuk, kondisi batas, dan beban diselesaikan dengan metode pendekatan. 

Pendekatan Metode Elemen Hingga adalah menggunakan informasi-informasi 

pada titik simpul (node). Dalam proses penentuan titik simpul yang disebut 

dengan pendiskretan (discretization), suatu sistem dibagi menjadi bagian-bagian 

yang lebih kecil, kemudian penyelesaian masalah dilakukan pada bagian-bagian 

tersebut dan selanjutnya digabung kembali sehingga diperoleh solusi secara 

menyeluruh. Dalam pengerjaan studi ini, digunakan software Metode Elemen 

Hingga. Software ini adalah program paket yang dapat memodelkan Elemen 

Hingga untuk menyelesaikan masalah yang berhubungan dengan mekanika, 

termasuk di dalamnya masalah statis, dinamik, analisis struktural (baik linier 

maupun nonlinier), masalah perpindahan panas, masalah fluida, dan juga masalah 

yang berhubungan dengan akustik dan elektromagnetik. Secara umum 

penyelesaian Elemen Hingga dapat dibagi menjadi tiga tahap, yaitu:  

1) Preprocessing: pendefinisian masalah  

Langkah umum dalam preprocessing terdiri dari mendefinisikan keypoint/ 

lines/areas/volume, mendefinisikan tipe elemen dan bahan yang 

digunakan/sifat geometrik, dan mesh lines/areas/volumes sebagaimana 

yang dibutuhkan. Jumlah detail yang dibutuhkan akan tergantung pada 

dimensi daerah yang dianalisis: 1D, 2D, axisymmetric, dan 3D.  

2) Solution: assigning loads, constraints, and solving  

Di bagian ini, perlu menentukan beban (titik atau tekanan), constraints 

(translasi dan rotasi), dan kemudian menyelesaikan hasil persamaan yang 

telah diset.  
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3) Postprocessing: further processing and viewing of the results  

Dalam bagian ini, pengguna dapat melihat: daftar pergeseran nodal, gaya 

elemen dan momentum, plot deflection, dan diagram kontur tegangan 

(stress) atau pemetaan suhu (K.N. Hoque, 2013). 

 

Penyelesaian masalah matematika analitik ialah penyelesaian yang memberikan 

persamaan-persamaan matematika dengan nilai-nilai besaran yang tidak diketahui 

pada tiap lokasi di dalam benda (dalam hal ini struktur atau sistem fisik total). 

Penyelesaian ini pada umumnya membutuhkan penyelesaian sederhana atau 

persamaan-persamaan diferensial parsial, karena untuk geometri, pembebanan, 

dan sifat-sifat bahan yang rumit tidak selalu dapat diperoleh (Hongyang Ma, 

2021). 

 

Berikut diberikan persamaan-persamaan matematika yang berkaitan dengan gaya 

tekan dan gaya tarik yang terjadi pada sebuah struktur (David Parulian Sitorus, 

2013): 

 

1. Gaya Tekan 

 

Suatu komponen yang mengalami gaya tekan, akibat beban terfaktor NU, harus 

memenuhi: 

 

 (2.1) 

   

Faktor reduksi untuk komponen struktur yang memiliki gaya tekan aksial sebesar 

0,85. Daya dukung nominal struktur tekan dihitung sebagai berikut: 

 

 
(2.2) 

 

Dengan besarnya   ditentukan oleh    yaitu: 

 

Untuk         maka     

Untuk             maka   
    

           
 (2.3) 

Untuk        maka          
   

 

Di mana: 

 

 
(2.4) 
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(2.5) 

 

Dalam mendesain batang tekan, bahaya tekuk sangat diperhitungkan pada 

komponen-komponen tekan yang langsing. Panjang tekuk tergantung dari kondisi 

tumpuan ujungnya. 

 

Tabel 2.1  Panjang Tekuk untuk Beberapa Kondisi Perletakan 

Garis putus 

menunjukkan 
posisi kolom 
pada saat 

tertekuk 

    
  

Harga K teoretis 0,5 0,7 1,0 1,0 2,0 2,0 

K desain 0,65 0,80 1,2 1,0 2,10 2,0 

Keterangan 

 

 

Komponen struktur tekan dapat tersusun dari dua atau lebih profil, yang disatukan 

dengan menggunakan pelat kopel. Analisis kekuatannya harus dihitung terhadap 

sumbu bahan dan sumbu bebas bahan. Kelangsingan pada arah sumbu bahan 

(sumbu x) dihitung dengan: 

 

 
(2.6) 

 

Dan pada arah sumbu bebas bahan (sumbu y) harus dihitung kelangsingan ideal: 

 

 
(2.7) 
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Gambar 2.1 Nilai Batas Kelangsingan Penampang untuk Berbagai Tipe Penampang 
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2. Gaya Tarik 

 

Batang tarik sangat efektif dalam memikul beban. Batang tarik dapat terdiri dari 

profil tunggal ataupun profil-profil tersusun. Semua komponen struktur yang 

memikul gaya tarik aksial terfaktor, maka diperoleh: 

Bila kondisi leleh menentukan, maka tahanan nominal dari batang tarik memenuhi 

persamaan: 

 

 (2.8) 

 

Untuk mengurangi masalah terkait dengan lendutan besar, maka komponen 

struktur tarik harus memenuhi syarat kekakuan. Syarat ini berdasarkan pada rasio 

kelangsingan, yaitu: 

 

 
(2.9) 

           

Tegangan rata-rata di dalam batang diberikan: 

 

 
(2.10) 

 

Regangan normal rata-rata dari elemen didefinisikan sebagai pengganti panjang 

Dl per satuan panjang mula-mula dari elemen: 

 

 
(2.11) 

  

Melewati daerah elastis, tegangan dan regangan dihubungkan dengan hukum 

Hooke berdasarkan persamaan:  

 

 (2.12) 

 

2.3 Penjelasan Metode 

 

Secara umum, masalah teknik adalah model matematis dari situasi fisik. Model 

matematis adalah persamaan diferensial yang terhubung dengan kondisi awal dan 

syarat batas.  

 

Persamaan diferensial diturunkan dengan menerapkan hukum dasar dan prinsip 

alamiah terhadap sebuah sistem atau volume kontrol. Persamaan ini 
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menggambarkan keseimbangan massa, gaya, atau energi. Jika mungkin, solusi 

eksak dari persamaan ini memberikan perilaku yang detail dari sebuah sistem 

yang diberikan dalam suatu kondisi. 

 

Solusi analitis terdiri dari dua bagian, yaitu: (1) bagian yang homogen; dan (2) 

bagian khusus. Dalam masalah keteknikan apa saja, ada dua parameter yang 

mempengaruhi kedua solusi tersebut dalam sebuah perilaku sistem. Pertama, ada 

parameter yang menyediakan informasi berkenaan dengan perilaku alamiah dari 

sebuah sistem yang diberikan. Parameter ini termasuk properties seperti modulus 

elastisitas, konduktivitas termal, dan viskositas. Di sisi lain, ada parameter yang 

menghasilkan gangguan di dalam sistem. Contoh dari parameter ini termasuk 

gaya eksternal, momen, perbedaan temperatur yang melewati medium, dan 

perbedaan tekanan di dalam aliran fluida. 

 

Banyak masalah keteknikan yang mana tidak diperoleh solusi yang pasti. 

Ketidakmampuan untuk memperoleh solusi pasti mungkin disebabkan pada 

kesulitan dalam membentuk persamaan diferensial atau kesulitan yang muncul 

dari kesesuaian kondisi awal dan syarat batas. Untuk menyelesaikan masalah 

tersebut, digunakan pendekatan metode numerik. 

 

Berbeda dengan solusi analitis, yang menunjukkan perilaku eksak dari sebuah 

sistem pada titik mana pun dari sebuah sistem, solusi numerik mendekati 

penyelesaian eksak hanya pada titik diskret yang disebut “node”. Langkah 

pertama dari prosedur numerik adalah diskretisasi. Proses ini membagi 

medium/objek ke dalam sebuah jumlah subregion yang kecil dan node. Ada dua 

klasifikasi dari metode numerik: (1) Metode Beda Hingga; dan (2) Metode Elemen 

Hingga. 

 

Metode Beda Hingga, persamaan diferensial ditulis untuk setiap titik, dan 

turunannya diganti dengan persamaan pembeda. Pendekatan ini menghasilkan 

suatu bentuk persamaan linear simultan. Meskipun Metode Beda Hingga mudah 

untuk dipahami dan diterapkan di dalam masalah sederhana, namun akan menjadi 

sulit untuk diterapkan ke dalam masalah dengan bentuk yang kompleks atau 

kondisi batas yang kompleks. Situasi tersebut juga sulit untuk diterapkan pada 

masalah material non-isotropik. 

 

  



 

11 

 

ANGLE-BAR 

BAB 3 ANGLE-BAR 

 

 

 

 

1. Data Pelat 

 

Data pelat berupa material yang digunakan adalah tipe material, modulus 

elastisitas, densitas, poison ratio disertai dengan ukuran ketebalan pelat. Adapun 

pada contoh material berikut adalah data Angle-bar. Jenis material yang 

digunakan adalah tipe AH37 dengan modulus elastisitas = 210000 N/mm2, 

densitas = 7.8 × 10-5 N/mm3, poison ratio = 0.3. Gambaran ukuran utama Angle-

bar ditampilkan pada gambar berikut: 

 

 

Gambar 3.1 Ukuran Angle-bar pada Tumpuan Jepit-Jepit 

 

2. Input Data Material Pelat 

 

Objek yang dianalisis diberikan sebagai berikut: klik File – Change Title (muncul 

kotak dialog Change Title). Pada [/TITLE] Enter New Title isikan “Analisis 

Angle-bar Tumpuan Jepit-Jepit” lalu klik Ok. Seperti yang terlihat pada gambar: 

 

BAB 
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350 mm 
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Gambar 3.2 Title 

 

Karena persoalan yang dianalisis adalah tentang struktur, maka dipilih structural 

dengan cara pilih Preferences (muncul kotak dialog Preferences for GUI 

Filtering) – pilih h-Method Ok. Pilih Preference pada main menu dan akan 

muncul kotak dialog seperti pada gambar: 

 

 

Gambar 3.3 Window Preferences for GUI Filtering 

 

Pemilihan jenis tipe elemen yang digunakan adalah dengan cara pilih 

Preprocessor > Element Types > Add/Edit/Delete > Add > Pilih Material 

> ok > Close. Pilih Preprocessor pada main menu kemudian akan muncul 

beberapa pilihan sub menu. Pilih Element Types untuk menentukan jenis 

material yang digunakan struktur. Setelah itu akan muncul beberapa pilihan menu. 

Pilih Add/Edit/Delete akan muncul kotak dialog seperti pada gambar: 
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Gambar 3.4 Window Element Types belum Terisi Jenis Material 

 

Setelah tampilan dialog muncul, pilih Add untuk menambahkan jenis material 

yang akan digunakan, selanjutnya akan muncul kotak dialog Library of Element 

Types seperti pada gambar: 

 

 

Gambar 3.5 Library of Element Types 

 

Setelah itu, akan muncul jenis material yang disediakan oleh ANSYS, pilih material 

Shell dengan Type 3D 4Node 181 lalu tekan Ok. Kemudian dialog Defined 

Element Types akan menambahkan material tersebut untuk digunakan sebagai 

material struktur seperti pada gambar berikut dan Close kotak dialog. 
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Gambar 3.6 Window Element Types yang telah Terisi Material 
 

Berikut langkah untuk menentukan atau memberikan nilai properties Material 

Shell. Material properties disesuaikan dengan material yang digunakan, karena 

setiap material memiliki properties masing-masing. 

Berikut ini langkah yang digunakan untuk memberikan nilai properties dari 

sebuah material. Material Props > Material Models > Structural > Linear > 

Elastic > Isotropic (ditunjukkan seperti gambar): 

 

 

Gambar 3.7 Window Defined Material Property Linear 
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3. Properties Material Pelat 

 

Pada baris EX berikan nilai 2.1 × 105 sebagai nilai modulus elastisitas dan pada 

baris PRXY berikan 0.3 sebagai Poisson’s Ratio kemudian klik Ok. 

 

Karena analisis yang dilakukan adalah analisis nonlinear dengan langkah sebagai 

berikut: Material Props > Material Models > Structural > Nonlinear > 

Inelastic > Rate Independent > Isotropic Hardening Plastic > Mises 

Plasticity > Bilinear (ditunjukkan pada gambar): 

 

 

Gambar 3.8 Window Defined Material Property Bilinear 

 

Pada baris Yield Stress berikan nilai 370 sebagai nilai tegangan luluh pada baris 

Tang Mod berikan 675 sebagai tangen modulus kemudian klik Ok. 

 

Ketebalan Area Element akan diberikan ketika melakukan Mesh Atribut. 

Adapun langkah memberi ketebalan material adalah sebagai berikut (sebagai 

contoh menggambarkan elemen pelat). Preprocessor > Section > Shell > Lay 

Up > Add/Edit. Adapun tampilan kotak dialog setelah proses tersebut seperti 

yang ditunjukkan pada gambar: 
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Gambar 3.9 Window Create and Modify Shell Sections 
 

Pada baris Name isi nama bagian pelat sesuai ketebalannya, baris ID isi nomor 

ID ketebalan pelat sesuai dengan urutan bagian pelat, Thickness isi ketebalan 

bagian pelat yang diinginkan, baris Material ID digunakan sesuai dengan 

Material Model’s yang telah diisi sebelumnya dan Orientation, Integration 

Pts, Pictorial View, dan lain-lain tidak perlu diubah.  

 

4. Model Struktur Pelat 

 

Dalam software pemodelan di ANSYS, penggambaran struktur Angle-bar, dengan 

langkah awal adalah dengan menentukan titik-titik pembentukannya yang terdiri 

dari beberapa keypoints. Berikut langkah yang akan dilakukan: Preprocessor > 

Modelling > Create > Keypoint > in active CS (muncul Create Keypoints in 

Active Coordinate System) pada windows isikan nomor keypoint (Keypoint 

number) dan koordinatnya (X,Y,Z Location in active CS) seperti pada gambar: 

 

 

Gambar 3.10 Window Create Keypoints in Activite Coordinate System 
 

Adapun cara penentuan koordinat penyusunan titik keypoint di ANSYS teratur, 

maka langkah awal yang dilakukan yaitu membuat titik xyz diisi (0,0,0) pada 
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Create Keypoint in Active Coordinate System yang menjadi sumbu global 

acuan. Kemudian masukkan koordinat yang diukur di AutoCAD secara berurutan 

karena pada AutoCAD mengikuti pola gambar tersebut. Adapun hasil gambar 2 

dimensi yang telah dibuat di ANSYS dapat dilihat pada gambar: 

 

 

Gambar 3.11 Keypoint 2D di ANSYS 

 

Apabila koordinat telah diinput dalam bentuk keypoint di ANSYS, langkah 

selanjutnya adalah menghubungkan keypoint tersebut menjadi garis-garis (line) 

dengan cara: Preprocessor > Modelling > Create > Line > Lines > Straight 

Line (muncul window Create Straight Line): 

 

 

Gambar 3.12 Window Create Straight Line 
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Setelah muncul window seperti gambar, maka klik Keypoint sesuai dengan 

nomor urutan gambar untuk menghubungkan garis satu dengan yang lainnya, 

sehingga akan terbentuk sebagian body pelat seperti pada gambar berikut ini: 

 

 

Gambar 3.13 Model 2D yang telah Terhubung Garis 
 

Setelah seluruh keypoint sudah dihubungkan menjadi garis-garis, langkah 

selanjutnya adalah garis-garis (line) tersebut di-copy agar pelat menjadi 3 dimensi 

dengan cara: Preprocessor > Copy > Line > Lines (muncul window Copy 

Lines) seperti gambar: 

 

  

Gambar 3.14 Window Copy Lines 
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Pada kolom DZ Z-offset in active CS isi dengan panjang pelat 350 mm 

kemudian klik Ok. Secara otomatis garis yang di-copy tadi akan tergandakan 

menjadi dua sesuai jarak yang diberikan seperti pada gambar berikut ini. 

 

 

Gambar 3.15 Model yang Telah Memiliki Area di ANSYS 
 

5. Pemberian Tebal Pelat 

 

Adapun cara memasukkan ketebalan pelat di ANSYS adalah sebagai berikut. 

Preprocessor > Meshing > Mesh Attributes > Pick Area (muncul window 

Area Attributes) seperti gambar: 

 

 

Gambar 3.16 Window Area Attributes 
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Setelah muncul tampilan seperti gambar, arahkan cursor pada area yang ingin 

dimasukkan ketebalannya seperti gambar: 

 

 

Gambar 3.17 Area Terblok yang Ingin Dimasukkan Ketebalannya 

 

Lalu klik Ok maka akan muncul window seperti gambar: 

 

 

Gambar 3.18 Area Attributes Pemilihan Ketebalan 
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6. Menggabungkan Semua Elemen pada Pelat 

 

Setelah memasukkan ketebalan pelat, selanjutnya perlu dipastikan elemen-elemen 

pada pelat saling berkaitan satu sama dengan yang lainnya dengan cara klik 

Preprocessor > Numbering Control > Merge Items (muncul window Merge 

Coincident or Equivalently Defined Items) seperti pada gambar: 

 

 

Gambar 3.19 Window Merge Coincident or Equivalently Defined Items 
 

Pada kolom label Type of Item to be Merge Option yang harus dipilih adalah 

All. Setelah itu meng-glue pelat tersebut dengan cara Preprocessor > 

Modelling > Operate > Booleans > Glue > Areas (akan muncul window Glue 

Areas) seperti gambar: 
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Gambar 3.20 Window Glue Areas 

 

Setelah muncul tampilan seperti pada gambar, klik Pick All. Perlu diketahui 

apabila terjadi masalah pada saat glue, hal itu berarti model yang dibuat ada 

masalah, sehingga perlu dicek terlebih dahulu apakah ada garis atau keypoint 

yang tidak saling berhubungan satu sama dengan yang lainnya karena glue 

sangat berpengaruh dengan proses running, maka perlu dipastikan apakah 

struktur ter-glue dengan baik atau tidak. 

 

7. Pemberian Ukuran Mesh 

 

Berikut ini ukuran mesh yang diberikan 10 (jika jarak mesh terlalu kecil, maka 

dapat diperbesar dengan memasukkan nilai mesh lebih besar lagi) dan cara klik 

Preprocessor > Meshing > Size cntrls > Manual Size > Area > All Areas 

(muncul window Element Sizes on All Selected Areas) lalu pada baris SIZE 

berikan 10 lalu klik ok seperti pada gambar: 

 

 

Gambar 3.21 Window Element Sizes on All Selected Areas 
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Mesh yang telah diberikan jarak 10 akan ditampilkan dengan klik Preprocessor > 

Mesh Tool (muncul window Mesh Tools) lalu klik Mesh. Pada kolom Mesh 

option yang dipilih adalah Quad dan Mapped seperti gambar: 

 

 

Gambar 3.22 Window Mesh Tool 
 

Setelah itu akan muncul window Mesh Areas lalu klik Pick All: 

 

 

Gambar 3.23 Window Mesh Areas 
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8. Pemberian Tumpuan dan Beban 

 

Adapun cara pemberian tumpuan pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Displacement > On Nodes 

(pilih Nodes dari kedua sisi ujung pelat) seperti pada gambar: 

 

  

Gambar 3.24 Pemberian Tumpuan pada Pelat Angle-bar 
 

Lalu klik Ok maka akan muncul window seperti pada gambar: 

 

 

Gambar 3.25 Window Apply U,ROT on Nodes 
 



 

25 

Pada gambar dapat dilihat pada kolom Lab2 DOFs to be constrained pilih All 

DOF dan pada kolom VALUE displacement value isi dengan angka 0 lalu klik 

Ok maka tumpuan pada bagian depan akan muncul seperti gambar: 

 

 

Gambar 3.26 Setelah Pelat Ditumpu 
 

Adapun cara pemberian beban pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Force/Moment > On 

Nodes (pilih Nodes pada bagian tengah pelat) seperti pada gambar: 

 

 

Gambar 3.27 Pemberian Beban pada Pelat 
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Klik Ok, kemudian akan muncul window seperti gambar:  

 

 

Gambar 3.28 Pemberian Jumlah Beban 
 

Berdasarkan gambar, pada kolom Lab Direction of Force/mom pilih jenis 

beban yang akan dimasukkan, yaitu momen arah y (MY), pada kolom Apply As 

pilih Constant Value dan pada kolom Value Force/Moment Value masukkan 

besar momen yang ingin dimasukkan. 

 

 

Gambar 3.29 Setelah Diberikan Beban pada Pelat 

 

9. Running Program 

 

Sebelum melakukan proses running perlu mengatur (setting) proses analisis yang 

akan dilakukan. Adapun caranya adalah klik Solution > Analysis Type > New 
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Analysis (muncul window New Analysis), klik Static kemudian klik Ok seperti 

yang ditunjukkan pada gambar: 

 

 

Gambar 3.30 Window New Analysis 
  

Setelah men-setting New Analysis, selanjutnya adalah klik Solution > Analysis 

Type > Sol’n Control (muncul window Solution Controls) seperti gambar: 

 

 

Gambar 3.31 Window Solution Controls 
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Gambar menunjukkan setting-an untuk basic control. Setting-an selanjutnya 

adalah Sol’n Options seperti yang ditunjukkan gambar: 

 

 

Gambar 3.32 Window Solution Controls 
 

Setelah Sol’n Options di-setting, selanjutnya menuju ke setting-an Advanced 

NL seperti yang ditunjukkan gambar:  

 

 

Gambar 3.33 Window Sol'n Options Setting untuk Running 
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Setelah langkah-langkah setting di atas sudah dilakukan kemudian klik Ok. 

Langkah-langkah yang sudah dilakukan di atas akan dicek apakah sudah berhasil 

dilakukan dengan cara mengeksekusinya. Dengan cara Solution > Solve > 

Current LS (muncul window /STATUS Command) lalu klik Ok (muncul window 

Solve Current Load Step) seperti yang ditunjukkan pada gambar: 

 

 

Gambar 3.34 Window Solve Current Load Step 
 

Dari gambar, window /STATUS Command bisa di-close saja agar tidak 

menghalangi display running, kemudian klik Ok akan muncul window Verify, lalu 

klik Yes. Seperti yang ditunjukkan pada gambar: 

 

 

Gambar 3.35 Window Verify Sebelum Running 
 

Setelah proses running selesai, ANSYS akan mengeluarkan pemberitahuan 

Solution is done! Apabila proses running bermasalah, maka muncul 

pemberitahuan pada layar monitor. Adapun proses running yang berhasil dapat 

dilihat: 
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Gambar 3.36 Window Note Running Down 

 

Demikianlah tata cara analysis kekuatan pelat Angle-bar dengan menggunakan 

metode Nonlinear Finite Element Analysis (NLFEA) di ANSYS. 

 

10. Tampilan Deformasi Pelat 

 

Adapun langkah-langkah melihat bentuk deformasi yang diakibatkan ultimate 

strength di ANSYS yaitu klik General Postproc > Read Results > By Pick 

Read > Close 

 

 

Gambar 3.37 Window Results File 
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Langkah selanjutnya klik Plot Result > Contour Plot > Nodal Solution 

(muncul window Contour Nodal Solution Data) > Nodal Solution > DOF 

Solution > Displacement vector sum > Scale Factor (Auto Calculated) > 

Ok. Seperti pada gambar: 

 

 

Gambar 3.38 Window Contour Nodal Solution Data 
 

Setelah langkah-langkah di atas dilakukan dengan benar, maka deformasi yang 

diakibatkan ultimate strength akan muncul seperti pada gambar: 
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Gambar 3.39 Deformasi Angle-bar 
 

11. Tampilan Grafik Stress-Strain 

 

Adapun langkah-langkahnya yakni mengambil nilai nodal solution untuk 

menentukan nilai stress dan strain di ANSYS dengan mengklik General Postproc 

> List Results > Nodal Solution > DOF Solution > Displacement Vector 

Sum > Ok seperti pada gambar berikut: 

 

 

Gambar 3.40 Window List Nodal Solution 
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Setelah itu akan muncul list data PRNSOL Command kemudian klik File > Save 

As lalu ganti nama File Name lalu Save. 

 

 

Gambar 3.41 Save File ANSYS 
 

12. Cara Plot Grafik Hasil Analisis pada ANSYS dengan MS Excel 

 

Setelah mendapatkan nilai stress dan strain, langkah selanjutnya adalah plot data 

tersebut menjadi sebuah grafik hubungan tegangan regangan. Adapun langkah-

langkahnya adalah sebagai berikut: 

1. Export data dari ANSYS menggunakan teks editor MARUO 

2. Setelah data dari ANSYS terbuka di MARUO, copy data tersebut ke MS Excel 

3. Plot data tersebut menjadi grafik di MS Excel dengan sumbu y adalah 

tegangan dan sumbu x adalah regangan. 

4. Selesai 

 

Adapun hasil yang diperoleh dari MS Excel setelah melakukan analisis ANSYS dan 

hasil menggunakan MS Excel dapat dilihat pada gambar: 
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Gambar 3.42 Grafik Tegangan Regangan Angle-bar 
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FLAT-BAR 

BAB 4 FLAT-BAR 

 

 

 

 

1. Data Pelat 

 

Data pelat berupa material yang digunakan adalah tipe material, modulus 

elastisitas, densitas, poison ratio disertai dengan ukuran ketebalan pelat. Adapun 

pada contoh material berikut adalah data Flat-bar. Jenis material yang digunakan 

adalah tipe AH37 dengan modulus elastisitas = 210000 N/mm2, densitas = 7.8 × 

10-5 N/mm3, poison ratio = 0.3. Gambaran ukuran utama Angle-bar ditampilkan 

pada gambar berikut: 

 

 

Gambar 4.1 Penampang Flat-bar 
 

2. Input Data Material Pelat 

 

Objek yang dianalisis diberikan sebagai berikut: klik File – Change Title (muncul 

kotak dialog Change Title). Pada [/TITLE] Enter New Title isikan “Analisis 

Flat-bar Tumpuan Jepit-Jepit” lalu klik Ok. Seperti yang terlihat pada gambar: 

 

BAB 

4 

 

 

 

100 mm 350 mm 

 

4.5 mm 
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Gambar 4.2 Change Title 
 

Karena persoalan yang dianalisis adalah tentang struktur, maka dipilih Structural 

dengan cara pilih Preferences (muncul kotak dialog Preferences for GUI 

Filtering) – pilih h-Method Ok. Pilih preference pada main dan akan muncul 

kotak dialog seperti pada gambar: 

 

 

Gambar 4.3 Preferences for GUI Filtering 
 

Pemilihan jenis tipe elemen yang digunakan adalah dengan cara pilih 

Preprocessor > Element Types > Add/Edit/Delete > Add > Pilih Material 

> Ok > Close. Pilih preprocessor pada main menu kemudian akan muncul 

beberapa pilihan sub menu. Pilih Element Types untuk menentukan jenis 

material yang digunakan struktur. Setelah itu akan muncul beberapa pilihan menu. 

Pilih Add/Edit/Delete akan muncul kotak dialog seperti pada gambar: 
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Gambar 4.4 Defined Element Types: NONE DEFINED  

 

Setelah tampilan dialog muncul, pilih Add untuk menambahkan jenis material 

yang akan digunakan, selanjutnya akan muncul kotak dialog Library of Element 

seperti pada gambar: 

 

 

Gambar 4.5 Library of Element Types 

 

Setelah itu, akan muncul jenis material yang disediakan oleh ANSYS, pilih 

Material Shell dengan Type 3D 4Node 181 lalu tekan Ok. Kemudian dialog 

Element Types akan menambahkan material tersebut untuk digunakan sebagai 

material struktur seperti pada gambar berikut dan Close kotak dialog. 
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Gambar 4.6 Defined Element Types: Type 1 SHELL181 
 

Berikut langkah untuk menentukan atau memberikan nilai Properties Material 

Shell. Material Properties disesuaikan dengan material yang digunakan, karena 

setiap material memiliki Properties masing-masing. 

Berikut ini langkah yang digunakan untuk memberikan nilai property dari sebuah 

material. Material Props > Material Models > Structural > Linear > Elastic 

> Isotropic (ditunjukkan seperti gambar) 

 

: 

Gambar 4.7 Define Material Model Behavior 
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3. Properties Material Pelat 

 

Pada baris EX berikan nilai 2.1 × 105 sebagai nilai modulus elastisitas dan pada 

baris PRXY berikan 0.3 sebagai Poisson’s Ratio kemudian klik Ok. 

 

Karena analisis yang dilakukan adalah analisis nonlinear dengan langkah sebagai 

berikut: Material Props > Material Models > Structural > Nonlinear > 

Inelastic > Rate Independent > Isotropic Hardening Plastic > Mises 

Plasticity > Bilinear (ditunjukkan pada gambar): 

 

 

Gambar 4.8 Material Models Defined 
 

Pada baris Yield Stress berikan nilai 370 sebagai nilai tegangan luluh pada baris 

Tang Mod berikan 675 sebagai tangen modulus kemudian klik Ok. 

 

Ketebalan Area Element akan diberikan ketika melakukan mesh atribut. Adapun 

langkah memberi ketebalan material adalah sebagai berikut (sebagai contoh 

menggambarkan elemen pelat). Preprocessor > Section > Shell > Lay Up > 

Add/Edit. Adapun tampilan kotak dialog setelah proses tersebut seperti yang 

ditunjukkan pada gambar: 



 

40 

 

Gambar 4.9 Create and Modify Shell Sections 
 

Pada baris Name isi nama bagian pelat sesuai ketebalannya, baris ID isi nomor 

ID ketebalan pelat sesuai dengan urutan bagian pelat, Thickness isi ketebalan 

bagian pelat yang diinginkan, baris Material ID digunakan sesuai dengan 

material model yang telah diisi sebelumnya dan Orientation, Integration Pts, 

Pictorial View, dan lain-lain tidak perlu diubah.  

 

4. Model Struktur Pelat 

 

Dalam software pemodelan di ANSYS, penggambaran struktur Flat-bar, dengan 

langkah awal adalah dengan menentukan titik-titik pembentukannya yang terdiri 

dari beberapa keypoints. Berikut langkah yang akan dilakukan: Preprocessor > 

Modelling > Create > Keypoint > In Activitas CS (muncul Create 

Keypoints in Active Coordinate System) pada windows isikan nomor keypoint 

dan koordinatnya seperti pada gambar: 

 

 

Gambar 4.10 Create Keypoint in Active Coordinate System 
 

Adapun cara penentuan koordinat penyusunan titik keypoint di ANSYS teratur, 

maka langkah awal yang dilakukan yaitu membuat titik xyz diisi (0,0,0) pada 
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Create Keypoint In Active Coordinate System yang menjadi sumbu global 

acuan. Kemudian masukkan koordinat yang diukur di AutoCAD secara berurutan 

karena pada AutoCAD mengikuti pola gambar tersebut. Adapun hasil gambar 2 

dimensi yang telah dibuat di ANSYS dapat dilihat pada gambar: 

 

 

Gambar 4.11 Nodes Flat-bar 

 

Apabila koordinat telah diinput dalam bentuk keypoint di ANSYS, langkah 

selanjutnya adalah menghubungkan keypoint tersebut menjadi garis-garis (line) 

dengan cara: Preprocessor > Modelling > Create > Line > Lines > Straight 

Line (muncul window Create Straight Line): 

 

 

Gambar 4.12 Create Straight Line 
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Setelah muncul window seperti gambar, maka klik Keypoint sesuai dengan 

nomor urutan gambar untuk menghubungkan garis satu dengan yang lainnya, 

sehingga akan terbentuk sebagian body pelat seperti pada gambar berikut ini: 

 

 

Gambar 4.13 Gambar 2D Flat-bar 
 

Setelah seluruh keypoint sudah dihubungkan menjadi garis-garis, langkah 

selanjutnya adalah garis-garis (line) tersebut di-copy agar pelat menjadi 3 dimensi 

dengan cara: Preprocessor > Copy > Line > Lines muncul window Copy 

Lines seperti gambar: 

 

 

Gambar 4.14 Copy Lines 
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Pada kolom DZ Z-offset in active CS isi dengan panjang pelat 350 mm 

kemudian klik Ok. Secara otomatis garis yang di-copy tadi akan tergandakan 

menjadi dua sesuai jarak yang diberikan seperti pada gambar berikut ini: 

 

 

Gambar 4.15 3D Flat-bar 
 

5. Pemberian Tebal Pelat 

 

Adapun cara memasukkan ketebalan pelat di ANSYS adalah sebagai berikut. 

Preprocessor > Meshing > Mesh Attributes > Pick Area (muncul window 

Area Attributes) seperti gambar: 

 

 

Gambar 4.16 Area Attributes (a) 
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Setelah muncul tampilan seperti gambar, arahkan cursor pada area yang ingin 

dimasukkan ketebalannya seperti gambar: 

 

 

Gambar 4.17 Input Ketebalan Flat-bar 
 

Lalu klik Ok maka akan muncul window seperti gambar: 

 

 

Gambar 4.18 Area Attributes (b) 
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6. Menggabungkan Semua Elemen pada Pelat 

 

Setelah memasukkan ketebalan pelat, selanjutnya perlu dipastikan elemen-elemen 

pada pelat saling berkaitan satu sama dengan yang lainnya dengan cara klik 

Preprocessor > Numbering Control > Merge Items (muncul window Merge 

Coincident) seperti pada gambar: 

 

 

Gambar 4.19 Merge Coincident or Equivalently Defined Items 
 

Pada kolom label Type of Item to be Merge Option yang harus dipilih adalah 

All. Setelah itu meng-glue pelat tersebut dengan cara Preprocessor > 

Modelling > Operate > Booleans > Glue > Areas (akan muncul window Glue 

Areas) seperti gambar: 

 

 

Gambar 4.20 Glue Areas 
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Setelah muncul tampilan seperti pada gambar, klik Pick All. Perlu diketahui 

apabila terjadi masalah pada saat glue hal itu berarti model yang dibuat ada 

masalah, sehingga perlu dicek terlebih dahulu apakah ada garis atau keypoint 

yang tidak saling berhubungan satu sama dengan yang lainnya karena glue 

sangat berpengaruh dengan proses running, maka perlu dipastikan apakah 

struktur ter-glue dengan baik atau tidak. 

 

7. Pemberian Ukuran Mesh 

 

Berikut ini ukuran Mesh yang diberikan 10 (jika jarak mesh terlalu kecil, maka 

dapat diperbesar dengan memasukkan nilai mesh lebih besar lagi) dan cara klik 

Preprocessor > Meshing > Size Cntrls > Manual Size > Area > All Area 

(muncul window Element Sizes on All Selected Areas) lalu pada baris SIZE 

Element edge length berikan 10 lalu klik Ok seperti pada gambar: 

 

 

Gambar 4.21 Element Sizes on All Selected Areas 
 

Mesh yang telah diberikan jarak 10 akan ditampilkan dengan klik Preprocessor 

> Mesh Tool (muncul window Mesh Tools) lalu klik Mesh. Pada kolom Mesh 

Option yang dipilih adalah Quad dan Mapped seperti gambar: 
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Gambar 4.22 Mesh Tool 
 

Setelah itu akan muncul window Mesh Area lalu klik Pick All. 

 

 

Gambar 4.23 Mesh Areas 
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8. Pemberian Tumpuan dan Beban 

 

Adapun cara pemberian tumpuan pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Displacement > On Nodes 

(pilih Nodes dari kedua sisi ujung pelat) seperti pada gambar: 

 

 

Gambar 4.24 Pemberian Tumpuan 
 

Lalu klik Ok maka akan muncul window seperti pada gambar: 

 

 

Gambar 4.25 Window Apply U,ROT on Nodes 
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Pada gambar dapat dilihat pada kolom Lab2 DOFs to be Constrained pilih All 

DOF dan pada kolom VALUE Displacement Value isi dengan angka 0 lalu klik 

Ok maka tumpuan pada bagian depan akan muncul seperti gambar: 

 

 

Gambar 4.26 Setelah Diberikan Tumpuan 
 

Adapun cara pemberian beban pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Force/Moment > On 

Nodes (pilih Nodes pada bagian tengah pelat) seperti pada gambar: 

 

 

Gambar 4.27 Pemberian Beban 
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Klik Ok, kemudian akan muncul window seperti gambar:  

 

 

Gambar 4.28 Window Apply F/M on Nodes 
 

Berdasarkan gambar, pada kolom Lab Direction Of Force/Mom pilih jenis 

beban yang akan dimasukkan yaitu momen arah y (MY), pada kolom Apply As 

pilih Constant Value dan pada kolom VALUE Force/Moment Value masukkan 

besar momen yang ingin dimasukkan. 

 

 

Gambar 4.29 Flat-bar Setelah Diberikan Beban 
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9. Running Program 

 

Sebelum melakukan proses running perlu mengatur (setting) proses analisis yang 

akan dilakukan. Adapun caranya adalah klik Solution > Analysis Type > New 

Analysis (muncul window New Analysis), klik Static kemudian klik Ok seperti 

yang ditunjukkan pada gambar: 

 

 

Gambar 4.30 New Analysis 
  

Setelah men-setting New Analysis, selanjutnya adalah klik Solution > Analysis 

Type > Sol’n Control (muncul window Solution Controls) seperti gambar: 

 

 

Gambar 4.31 Solution Controls 
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Gambar menunjukkan setting-an untuk Basic Control. Setting-an selanjutnya 

adalah Sol’n Options seperti yang ditunjukkan gambar: 

 

 

Gambar 4.32 Sol'n Options Solution Controls 
 

Setelah Sol’n Options di-setting, selanjutnya menuju ke setting-an Advanced 

NL seperti yang ditunjukkan gambar:  

 

 

Gambar 4.33 Arc-length Options 
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Setelah langkah-langkah setting di atas sudah dilakukan, kemudian klik ok. 

Langkah-langkah yang sudah dilakukan di atas akan dicek apakah sudah berhasil 

dilakukan dengan cara mengeksekusinya. Dengan cara Solution > Solve > 

Current LS (muncul window /STATUS Command) lalu klik Ok (muncul window 

Solve Current Load Step) seperti yang ditunjukkan pada gambar: 

 

 

Gambar 4.34 Window /STATUS Command 
 

Dari gambar, window /STATUS Command bisa di-close saja agar tidak 

menghalangi display Running, kemudian klik Ok akan muncul window Verify, 

lalu klik Yes. Seperti yang ditunjukkan pada gambar: 

 

 

Gambar 4.35 Window Verify 
 

Setelah proses running selesai, ANSYS akan mengeluarkan pemberitahuan 

Solution is done! Apabila proses running bermasalah, maka muncul 

pemberitahuan pada layar monitor. Adapun proses running yang berhasil dapat 

dilihat: 
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Gambar 4.36 Running Model 
 

Demikianlah tata cara analysis kekuatan pelat Angle-bar dengan menggunakan 

metode Nonlinear Finite Element Analysis (NLFEA) di ANSYS. 

 

10. Tampilan Deformasi Pelat 

 

Adapun langkah-langkah melihat bentuk deformasi yang diakibatkan ultimate 

strength di ANSYS yaitu klik General Postproc > Read Results > By Pick (pilih 

titik terjadi ultimate strength) > Read > Close. 

 

 

Gambar 4.37 Results File 
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Langkah selanjutnya klik Plot Result > Contour Plot > Nodal Solution 

(muncul window Contour Nodal Solution Data) > Nodal Solution > DOF 

Solution > Displacement vector sum > Scale Factor (Auto Calculated) > 

Ok. Seperti pada gambar: 

 

 

Gambar 4.38 Contour Nodal Solution Data 

 

Setelah langkah-langkah di atas dilakukan dengan benar, maka deformasi yang 

diakibatkan ultimate strength akan muncul seperti pada gambar: 
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Gambar 4.39 Deformasi Flat-bar 
 

11. Tampilan Grafik Stress-Strain 

 

Adapun langkah-langkahnya yakni mengambil nilai Nodal Solution untuk 

menentukan nilai Stress dan Strain di ANSYS dengan meng-klik General 

Postproc > List Results > Nodal Solution > DOF Solution > Displacement 

Vector Sum > OK seperti pada gambar berikut: 

 

 

Gambar 4.40 Window Nodal Solution 
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Setelah itu akan muncul list data PRNSOL Command kemudian klik File > Save 

As lalu ganti nama file lalu File Name > Save. 

 

 

Gambar 4.41 Window PRNSOL Command 

 

12. Cara Plot Grafik Hasil Analisis pada ANSYS dengan MS Excel 

 

Setelah mendapatkan nilai Stress dan Strain, langkah selanjutnya adalah plot 

data tersebut menjadi sebuah grafik hubungan tegangan regangan. Adapun 

langkah-langkahnya adalah sebagai berikut: 

1. Export data dari ANSYS menggunakan teks editor MARUO 

2. Setelah data dari ANSYS terbuka di MARUO, copy data tersebut ke MS Excel 

3. Plot data tersebut menjadi grafik di MS Excel dengan sumbu y adalah 

tegangan dan sumbu x adalah regangan 

4. Selesai 

 

Adapun hasil yang diperoleh dari MS Excel setelah melakukan analisis ANSYS dan 

hasil menggunakan MS Excel dapat dilihat pada gambar: 
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Gambar 4.42 Grafik Tegangan Regangan Flat-bar 
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TEE-BAR 

BAB 5 TEE-BAR 

 

 

 

 

1. Data Pelat 

 

Data pelat berupa material yang digunakan adalah tipe material, modulus 

elastisitas, densitas, poison ratio disertai dengan ukuran ketebalan pelat. Adapun 

pada contoh material berikut adalah data Tee-bar. Jenis material yang digunakan 

adalah tipe AH37 dengan modulus elastisitas = 210000 N/mm2, densitas = 7.8 × 

10-5 N/mm3, poison ratio = 0.3. Gambaran ukuran utama Angle-bar ditampilkan 

pada gambar berikut: 

 

 

Gambar 5.1 Penampang Tee-bar 
  

2. Input Data Material Pelat 

 

Objek yang dianalisis diberikan sebagai berikut: klik File – Change Title (muncul 

kotak dialog Change Title). Pada [/TITLE] Enter New Title isikan “Analisis 

Tee-bar Tumpuan Jepit-Jepit” lalu klik Ok. Seperti yang terlihat pada gambar: 

BAB 

5 

 

 

 
350 mm 
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Gambar 5.2 Change Title 
 

Karena persoalan yang dianalisis adalah tentang struktur, maka dipilih Structural 

dengan cara pilih Preferences (muncul kotak dialog Preferences for GUI 

Filtering) – pilih h-Method ok. Pilih Preferences pada main menu dan akan 

muncul kotak dialog seperti pada gambar: 

 

 

Gambar 5.3 Preferences for GUI Filtering 
 

Pemilihan jenis tipe elemen yang digunakan adalah dengan cara pilih 

Preprocessor > Element Types > Add/Edit/Delete > Add > pilih Material 

> Ok > Close. Pilih Preprocessor pada main menu kemudian akan muncul 

beberapa pilihan sub menu. Pilih Element Types untuk menentukan jenis 

material yang digunakan struktur. Setelah itu akan muncul beberapa pilihan menu. 

Pilih Add/Edit/Delete akan muncul kotak dialog seperti pada gambar: 
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Gambar 5.4 Window Defined Element Types: NONE DEFINED 
 

Setelah tampilan dialog muncul, pilih Add untuk menambahkan jenis material 

yang akan digunakan, selanjutnya akan muncul kotak dialog Library Of Element 

seperti pada gambar: 

 

 

Gambar 5.5 Library of Element Types 
 

Setelah itu, akan muncul jenis material yang disediakan oleh ANSYS, pilih material 

Shell dengan type 3D 4Node 181 lalu tekan Ok. Kemudian dialog Element 

Type akan menambahkan material tersebut untuk digunakan sebagai material 

struktur seperti pada gambar berikut dan Close kotak dialog. 
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Gambar 5.6 Window Defined Element Types: Type 1 SHELL181 
 

Berikut langkah untuk menentukan atau memberikan nilai properties Material 

Shell. Material properties disesuaikan dengan material yang digunakan, karena 

setiap material memiliki properties masing-masing. 

 

Berikut ini langkah yang digunakan untuk memberikan nilai property dari sebuah 

material. Material Props > Material Models > Structural > Linear > Elastic 

> Isotropic (ditunjukkan seperti gambar): 

 

 

Gambar 5.7 Materials Models Available 
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3. Properties Material Pelat 

 

Pada baris EX berikan nilai 2.1 × 105 sebagai nilai modulus elastisitas dan pada 

baris PRXY berikan 0.3 sebagai Poisson’s Ratio kemudian klik Ok. 

 

Karena analisis yang dilakukan adalah analisis nonlinear dengan langkah sebagai 

berikut: Material Props > Material Models > Structural > Nonlinear > 

Inelastic > Rate Independent > Isotropic Hardening Plastic > Mises 

Plasticity > Bilinear (ditunjukkan pada gambar): 

 

 

Gambar 5.8 Define Material Model Behavior 
 

Pada baris Yield Stress berikan nilai 370 sebagai nilai tegangan luluh pada baris 

Tang Mod berikan 675 sebagai tangen modulus kemudian klik Ok. 

 

Ketebalan Area Element akan diberikan ketika melakukan mesh atribut. Adapun 

langkah memberi ketebalan material adalah sebagai berikut (sebagai contoh 

menggambarkan elemen pelat). Preprocessor > Section > Shell > Lay Up > 

Add/Edit. Adapun tampilan kotak dialog setelah proses tersebut seperti yang 

ditunjukkan pada gambar: 
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Gambar 5.9 Create and Modify Shell Sections 
 

Pada baris Name isi nama bagian pelat sesuai ketebalannya, baris ID isi nomor 

ID ketebalan pelat sesuai dengan urutan bagian pelat, Thickness isi ketebalan 

bagian pelat yang diinginkan, baris Material Id digunakan sesuai dengan 

material model yang telah diisi sebelumnya dan Orientation, Integration Pts, 

Pictorial View, dan lain-lain 

 

4. Model Struktur Pelat 

 

Dalam software pemodelan di ANSYS, penggambaran struktur Tee-bar, dengan 

langkah awal adalah dengan menentukan titik-titik pembentukannya yang terdiri 

dari beberapa keypoints. Berikut langkah yang akan dilakukan: Preprocessor > 

Modelling > Create > Keypoint > in active CS (muncul Create Keypoints in 

Active Coordinate System) pada windows isikan nomor keypoint dan (X,Y,Z 

Location in active CS) koordinatnya seperti pada gambar: 

 

 

Gambar 5.10 Create Keypoints in Active Coordinate System 
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Adapun cara penentuan koordinat penyusunan titik keypoint di ANSYS teratur, 

maka langkah awal yang dilakukan yaitu membuat titik xyz diisi (0,0,0) pada 

Create Keypoint In Active Coordinate System yang menjadi sumbu global 

acuan. Kemudian masukkan koordinat yang diukur di AutoCAD secara berurutan 

karena pada AutoCAD mengikuti pola gambar tersebut. Adapun hasil gambar 2 

dimensi yang telah dibuat di ANSYS dapat dilihat pada gambar: 

 

 

Gambar 5.11 Node Tee-bar 

 

Apabila koordinat telah diinput dalam bentuk keypoint di ANSYS, langkah 

selanjutnya adalah menghubungkan keypoint tersebut menjadi garis-garis (line) 

dengan cara: Preprocessor > Modelling > Create > Line > Lines > Straight 

Line (muncul window Create Straight Line):  

 

 

Gambar 5.12 Create Straight Line 
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Setelah muncul windows seperti gambar, maka klik Keypoint sesuai dengan 

nomor urutan gambar untuk menghubungkan garis satu dengan yang lainnya, 

sehingga akan terbentuk sebagian body pelat seperti pada gambar berikut ini: 

 

 

Gambar 5.13 2D Tee-bar 
 

Setelah seluruh keypoint sudah dihubungkan menjadi garis-garis, langkah 

selanjutnya adalah garis-garis (line) tersebut di-copy agar pelat menjadi 3 dimensi 

dengan cara: Preprocessor > Copy > Line > Lines (muncul window Copy 

Lines) seperti gambar: 

 

 

Gambar 5.14 Window Copy Lines 
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Pada kolom DZ Z-offset in active CS isi dengan panjang pelat 350 mm 

kemudian klik Ok. Secara otomatis garis yang di-copy tadi akan tergandakan 

menjadi dua sesuai jarak yang diberikan seperti pada gambar berikut ini: 

 

 

Gambar 5.15 3D Tee-bar 
 

5. Pemberian Tebal Pelat 

 

Adapun cara memasukkan ketebalan pelat di ANSYS adalah sebagai berikut. 

Preprocessor > Meshing > Mesh Attributes > Pick Area (muncul window 

Area Attributes) seperti gambar: 

 

 

Gambar 5.16 Area Attributes 
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Setelah muncul tampilan seperti gambar, arahkan cursor pada area yang ingin 

dimasukkan ketebalannya seperti gambar: 

 

 

Gambar 5.17 Menambahkan Ketebalan pada Tee-bar 
 

Lalu klik Ok maka akan muncul window seperti gambar: 

 

 

Gambar 5.18 Area Attributes 
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6. Menggabungkan Semua Elemen pada Pelat 

 

Setelah memasukkan ketebalan pelat, selanjutnya perlu dipastikan elemen-elemen 

pada pelat saling berkaitan satu sama dengan yang lainnya dengan cara klik 

Preprocessor > Numbering Control > Merge Items (muncul window Merge 

Coincident or Equivalently Defined Items) seperti pada gambar: 

 

 

Gambar 5.19 Merge Coincident or Equivalently Defined Items 
 

Pada kolom label Type of Item to be Merge Option yang harus dipilih adalah 

all. Setelah itu meng-glue pelat tersebut dengan cara Preprocessor > 

Modelling > Operate > Booleans > Glue > Areas (akan muncul window Glue 

Areas) seperti gambar: 

 

 

Gambar 5.20 Glue Areas 
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Setelah muncul tampilan seperti pada gambar, klik Pick All. Perlu diketahui 

apabila terjadi masalah pada saat glue hal itu berarti model yang dibuat ada 

masalah, sehingga perlu dicek terlebih dahulu apakah ada garis atau keypoint 

yang tidak saling berhubungan satu sama dengan yang lainnya karena glue 

sangat berpengaruh dengan proses running, maka perlu dipastikan apakah 

struktur ter-glue dengan baik atau tidak. 

 

7. Pemberian Ukuran Mesh 

 

Berikut ini ukuran mesh yang diberikan 10 (jika jarak mesh terlalu kecil, maka 

dapat diperbesar dengan memasukkan nilai mesh lebih besar lagi) dan cara klik 

Preprocessor > Meshing > Size Cntrls > Manual Size > Area > All Area 

(muncul window Element Sizes on All Selected Areas) lalu pada baris SIZE 

berikan 10 lalu klik Ok seperti pada gambar: 

 

 

Gambar 5.21 Pemberian Ukuran Mesh 
 

Mesh yang telah diberikan jarak 10 akan ditampilkan dengan klik Preprocessor > 

Mesh Tool (muncul window Mesh Tools) lalu klik Mesh. Pada kolom Mesh 

option yang dipilih adalah Quad dan Mapped seperti gambar: 
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Gambar 5.22 Mesh Tool 
 

Setelah itu akan muncul window Mesh Areas lalu klik Pick All. 

 

 

Gambar 5.23 Mesh Area 
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8. Pemberian Tumpuan dan Beban 

 

Adapun cara pemberian tumpuan pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Displacement > On Nodes 

(pilih Nodes dari kedua sisi ujung pelat) seperti pada gambar: 

 

 

Gambar 5.24 Pemberian Tumpuan 
 

Lalu klik Ok maka akan muncul window seperti pada gambar: 

 

 

Gambar 5.25 Apply U,ROT on Nodes 
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Pada gambar dapat dilihat pada kolom Lab2 Dofs to be Constrained pilih All 

Dofs dan pada kolom VALUE displacement value isi dengan angka 0 lalu klik 

Ok maka tumpuan pada bagian depan akan muncul seperti gambar: 

 

 

Gambar 5.26 Tee-bar Sudah Diberi Tumpuan 

 

Adapun cara pemberian beban pada ANSYS adalah sebagai berikut: 

Solution > Define Load > Apply > Structural > Force/Moment > On 

Nodes (pilih Nodes pada bagian tengah pelat) seperti pada gambar: 

 

 

Gambar 5.27 Pemberian Beban pada Tee-bar 
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Klik Ok, kemudian akan muncul window seperti gambar:  

 

 

Gambar 5.28 Apply F/M on Nodes 
 

Berdasarkan gambar, pada kolom Lab Direction Of Force/Mom pilih jenis 

beban yang akan dimasukkan yaitu momen arah y (MY), pada kolom Apply As 

pilih Constant Value dan pada kolom Value Force/Moment Value masukkan 

besar momen yang ingin dimasukkan. 

 

 

Gambar 5.29 Tee-bar Setelah Diberi Beban 
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9. Running Program 

 

Sebelum melakukan proses running perlu mengatur (setting) proses analisis yang 

akan dilakukan. Adapun caranya adalah klik Solution > Analysis Type > New 

Analysis (muncul window New Analysis), klik Static kemudian klik Ok seperti 

yang ditunjukkan pada gambar: 

 

 

Gambar 5.30 Window New Analysis 
  

Setelah men-setting New Analysis, selanjutnya adalah klik Solution > Analysis 

Type > Sol’n Control (muncul window Solution Controls) seperti gambar: 

 

 

Gambar 5.31 Solution Controls 



 

76 

Gambar menunjukkan setting-an untuk basic control. Setting-an selanjutnya 

adalah Sol’n Options seperti yang ditunjukkan gambar: 

 

 

Gambar 5.32 Sol'n Options 
 

Setelah Sol’n Options di-setting, selanjutnya menuju ke setting-an Advanced 

NL seperti yang ditunjukkan gambar:  

 

 

Gambar 5.33 Arc-length Method 
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Setelah langkah-langkah setting di atas sudah dilakukan kemudian klik Ok. 

Langkah-langkah yang sudah dilakukan di atas akan dicek apakah sudah berhasil 

dilakukan dengan cara mengeksekusinya. Dengan cara Solution > Solve > 

current LS (muncul window /STATUS Command) lalu klik Ok (muncul window 

Solve Current Load Step) seperti yang ditunjukkan pada gambar: 

 

 

Gambar 5.34 STATUS Command 
 

Dari gambar, window /STATUS Command bisa di-close saja agar tidak 

menghalangi display running, kemudian klik Ok akan muncul window Verify, lalu 

klik Yes. Seperti yang ditunjukkan pada gambar: 

 

 

Gambar 5.35 Window Verify 
 

Setelah proses running selesai, ANSYS akan mengeluarkan pemberitahuan 

SOLUTION DONE. Apabila proses running bermasalah, maka muncul 

pemberitahuan pada layar monitor. Adapun proses running yang berhasil dapat 

dilihat: 
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Gambar 5.36 Running Program 
 

Demikianlah tata cara analisis kekuatan pelat Angle-bar dengan menggunakan 

metode Nonlinear Finite Element Analysis (NLFEA) di ANSYS. 

 

10. Tampilan Deformasi Pelat 

 

Adapun langkah-langkah melihat bentuk deformasi yang diakibatkan ultimate 

strength di ANSYS yaitu klik General Postproc > Read Results > By Pick (pilih 

titik terjadi ultimate strength) > Read > Close. 

 

 

Gambar 5.37 Results File 
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Langkah selanjutnya klik Plot Result > Counter Plot > Nodal Solution 

(muncul window Counter Nodal Solution Data) > Nodal Solution > DOF 

Solution > Displacement Vector Sum > Scale Factor (Auto Calculed) > 

Ok. Seperti pada gambar: 

 

 

Gambar 5.38 Contour Nodal Solution Data 
 

Setelah langkah-langkah di atas dilakukan dengan benar, maka deformasi yang 

diakibatkan ultimate strength akan muncul seperti pada gambar: 

 

 

Gambar 5.39 Deformasi Tee-bar 
 



 

80 

11. Tampilan Grafik Stress-Strain 

 

Adapun langkah-langkahnya yakni mengambil nilai nodal solution untuk 

menentukan nilai stress dan strain di ANSYS dengan mengklik General Postproc 

> List Results > Nodal Solution > DOF Solution > Displacement vector 

sum > Ok seperti pada gambar berikut: 

 

 

Gambar 5.40 List Nodal Solution 

 

Setelah itu akan muncul list data PRNSOL Command kemudian klik file > save 

as lalu ganti nama file lalu save. 

 

12. Cara Plot Grafik Hasil Analisis pada ANSYS dengan MS Excel 

 

 

Gambar 5.41 Window PRNSOL Command 
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Setelah mendapatkan nilai stress dan strain, langkah selanjutnya adalah plot 

data tersebut menjadi sebuah grafik hubungan tegangan regangan. Adapun 

langkah-langkahnya adalah sebagai berikut: 

1. Export data dari ANSYS menggunakan teks editor MARUO 

2. Setelah data dari ANSYS terbuka di MARUO, copy data tersebut ke MS Excel 

3. Plot data tersebut menjadi grafik di MS Excel dengan sumbu y adalah 

tegangan dan sumbu x adalah regangan. 

4. Selesai 

 

Adapun hasil yang diperoleh dari MS Excel setelah melakukan analisis ANSYS dan 

hasil menggunakan MS Excel dapat dilihat pada gambar: 

 

 

Gambar 5.42 Grafik Tegangan Regangan Tee-bar 
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PERBANDINGAN  
HASIL UJI LAB DAN FEM 

BAB 6 PERBANDINGAN HASIL UJI LAB DAN FEM 

 

 

 

 

Sebelum dilakukan analisis Finite Element Method di ANSYS, terlebih dahulu 

dilakukan pengujian pelat Angle-bar, Flat-bar, dan Tee-bar. Pengujian tarik pada 

pelat berpenegar ini dilakukan di laboratorium milik Departemen Teknik Mesin, 

Fakultas Teknik, Universitas Hasanuddin, Gowa. Dalam penelitian ini digunakan 5 

jenis pelat dalam satu tipe pelat baik Angle-bar, Tee-bar, dan Flat-bar yang 

masing-masing memiliki tegangan leleh rata-rata (fy) sebesar 560 Mpa untuk 

Angle-bar, 365 Mpa untuk Flat-bar dan 675 Mpa untuk Tee-bar. Berikut adalah 

gambaran uji laboratorium pada pelat sebelum dilakukan pembebanan. Gambaran 

hasil uji lab dan hasil deformasi dari FEM setelah pelat diberikan pembebanan 

yang kemudian telah terjadi perubahan pada struktur yang di mana terjadi 

lekukan maupun retakan pada struktur pelat: 

 

 

Gambar 6.1 Pelat Angle-bar, Flat-bar, dan Tee-bar 
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Gambar 6.2 Uji Lab Angle-bar 
 

 

Gambar 6.3 Hasil FEM ANSYS Angle-bar 
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Gambar 6.4 Uji Lab Flat-bar 
  

 

Gambar 6.5 Hasil FEM ANSYS Flat-bar 
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Gambar 6.6 Uji Lab Tee-bar 
 

 

Gambar 6.7 Hasil FEM ANSYS Tee-bar 
 

Dari hasil uji lab dan analisis FEM dengan menggunakan ANSYS, didapatkan grafik 

perbandingan tegangan dan regangan yang terjadi pada ketiga struktur pelat baik 

Angle-bar, Tee-bar, dan Flat-bar: 
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Gambar 6.8 Perbandingan Tegangan Regangan Uji Lab dan FEM ANSYS  
pada Angle-bar 

 

 

Gambar 6.9 Perbandingan Tegangan Regangan Uji Lab dan FEM ANSYS  

pada Flat-bar 
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Gambar 6.10 Perbandingan Tegangan Regangan Uji Lab dan FEM ANSYS  
pada Tee-bar 

 

Dari grafik di atas bisa dilihat perbandingan hasil uji lab dengan hasil analisis di 

ANSYS. Dan hasilnya relatif sama baik dengan hasil uji lab maupun hasil analisis 

dengan analisis ANSYS. 
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DISKUSI 

BAB 7 DISKUSI 

 

 

 

 

Analisis kekuatan pelat berpenegar merupakan kriteria yang sangat penting dalam 

desain struktur. Beberapa penelitian yang terkait dengan analisis pelat telah 

diuraikan dengan menggunakan metode untuk memperoleh hasil yang berupa 

respons struktur sebelum dan sesudah dibebani.  

 

Berbagai masalah yang dihadapi serta tujuan yang ingin dicapai dengan 

mempertimbangkan berbagai aspek, menjadikan kekuatan pelat menjadi analisis 

yang sangat kompleks. Oleh karena itu, dibutuhkan metode untuk mendapatkan 

informasi yang lebih detail dari perilaku struktur pelat sebelum dan setelah adanya 

pembebanan. 

 

Material, pemodelan, tebal pelat, pembebanan, running program, deformasi 

struktur serta plot grafik tegangan regangan yang juga disajikan dalam bentuk 

prosedur kerja dengan menggunakan ANSYS.  

 

Material yang digunakan pada struktur pelat adalah baja dengan spesifikasi 

modulus elastisitas, rasio poison, tangen modulus, densitas, dan tegangan luluh. 

Semua spesifikasi dari material ini dimasukkan ke dalam input data sesuai dengan 

kotak dialog yang tersedia di ANSYS. 

 

Pemodelan struktur dilakukan dengan menggunakan model pelat Angle-bar, Flat-

bar, dan Tee-bar. Untuk ukuran panjang pelat diasumsikan 350 mm. secara umum 

elemen yang digunakan adalah shell dengan titik yang dimodelkan pada pelat. 

Selanjutnya dimensi pelat juga dimasukkan pada input data. 

 

Setelah semua dimasukkan ke dalam input data, maka langkah selanjutnya adalah 

menggabungkan semua elemen dengan meng-glue dan kemudian di-meshing. 

Setelah di-meshing, maka dilanjutkan dengan pemberian tumpuan pada ujung 

pelat dan dilanjutkan pemberian beban pada bagian tengah pelat. 
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Proses running merupakan tahap akhir dari prosedur analisis untuk memperoleh 

hasil berupa distribusi tegangan, deformasi, lendutan elemen-elemen, dan gaya 

pelat dalam bentuk tiga dimensi. Hasil dari proses running ini juga dapat berupa 

teks editor yang bisa di-export dalam bentuk notepad, watpad, dan sejenisnya. 

Teks editor ini sangat berguna untuk meng-export data output dari ANSYS untuk 

dibawa ke MS Excel, kemudian dibuat grafik hubungan tegangan dan regangan. 
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KESIMPULAN 

BAB 8 KESIMPULAN 

 

 

 

 

Metode Elemen Hingga ialah suatu metode numerik yang dipergunakan untuk 

menyelesaikan masalah-masalah rekayasa dan matematika fisis. Ruang lingkup 

ilmu Metode Elemen Hingga ialah meliputi analisis struktur, pindahan panas, aliran 

fluida, perpindahan massa, dan potensial elektromagnetik. Metode ini merupakan 

penyempurnaan metode matematika analitik sederhana. Metode ini dapat 

memecahkan masalah-masalah rekayasa yang melibatkan geometri, beban, dan 

sifat-sifat bahan yang kompleks dan rumit yang tidak dapat diselesaikan dengan 

cara metode matematika analitik. Oleh karena itu, pengenalan Metode Elemen 

Hingga untuk menganalisis struktur pelat melalui referensi atau buku sangat 

dibutuhkan. 

 

Analisis kekuatan pelat dengan menggunakan Metode Elemen Hingga memberikan 

kontribusi yang sangat besar karena dapat memberikan informasi yang lebih detail 

perihal perilaku struktur pelat sebelum dan setelah pembebanan. Informasi detail 

struktur pelat berupa distribusi tegangan, deformasi, dan sebagainya ditampilkan 

dalam bentuk tiga dimensi sehingga memberikan gambaran kepada user apakah 

perilaku tersebut sesuai dengan kondisi nyata. 

 

Metode Elemen Hingga ini menggunakan prinsip diskretisasi yang dirangkum 

dalam tiga fase yaitu: fase Preprocessing, fase Solusi, dan fase Postprocessing 

yang saling terintegrasi satu dengan yang lainnya. 

 

Output dari ANSYS berupa grafik tegangan regangan yang kemudian 

dibandingkan dengan hasil uji laboratorium yang telah dilakukan sebelumnya. 
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